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About Page Flipping PDF Pro

Page Flipping PDF Professional is software
designed to easily and quickly convert rigid PDF
files into vivid Flipping Page e-Books! Page Flipping
PDF Pro is enable to add Video, Flash, Hyperlinks,
YouTube, Sounds, Pictures, Logo and Watermarks
on pages, which would help to extend the
persuasion and influence of your page flip e-books.
With using Page Flipping PDF Pro, different formats
flipping books output to run on Mac, PC, iPhone
and other mobile devices holders. No extra
programming needed, you can be a wonderful

book designer!

Note: This product is based on a "Try before-you-buy" principle. All
features mentioned in this instrument can be realized. Once you
bought the software, you would get a unique register, and the
registered version doesn't insert our watermark in your generated

page flipping ebooks.
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Product features

10.

Convert PDF files to Adobe®© Flash® based page-flipping eBooks.

Import the page of PDF: all pages or custom range of pages.

Five kinds of page quality can be chosen for different file size output.

While importing pages, you can add different text or image watermarks on pages to protect
authority of your Flipping Page book.

Import bookmark: retain your PDF structure and guide readers with easy chapter layout.
Import links: publicize your company or institution well.

Enable search: enable readers search the keyword quickly in your flipping book.

Detect wide pages: detect and cut a landscape page into two portrait orientation pages.

Batch convert multiple PDF files to a single or multiple page-flipping eBooks.

Provide command line version.

11. There are Six formats that Page Flip PDF will take to you:

12.

13.

14,

® Html, it makes your publication can be distributed on-line or just view offline;

® Zip, it helps you to transmit your publication through the E-mail;

® Mobile version, when output book in HTML or ZIP format, you can also give a check mark
to make mobile version at the same time, which will make your page flipping ebook
works on iPad, iPhone and Android mobile devices;

® Exe, it let your publication can be used in your computer separately;

® Mac App, Application Flipping E-books form can be run on Mac;

® Burn to CD/DVD, you can choose a disk to your flip book, it will not ask for specified
memory address.

Upload created book onto PageFlippingping website server directly.

Four templates of themes: Classical, Float, Spread and Neat, every different templates has its

distinct functions.

Show or hide Tool bar or buttons, like Home, About, Help, Full Screen, Print, and Download

etc.

Copyright 2012 by Page-Flipping.com
-2-



e mh N PDF to Professional Page-Flipping eBook Utility
= i \/ User Document

15. Add title and page URL to publicize your web, also the page can be open in self or blank page.

16. Insert information about you author, the book, or your company easily in "About" window.

17. Give permission to readers for them download PDF, ZIP, EXE book to view your book locally.

18. Make your flipping book more attractive with embedding background sound situation.

19. Enable Zoom in and make your flipping book more humanized, also the zoom scale can be set.

20. Support Auto Flip for readers to view your book in custom speed, without moving or clicking.

21. Set color for icon, flash window and font.

22. Design background with color, image, and you can also set transparency of background to
show the background of other HTML when embedded into the HTML page.

23. Retain the book in center, or add ads in the left side.

24. Page width, height, margin, shadow and opacity all can be written in.

25. Choose a hard cover to your flipping e-book to make the book more realistic.

26. The form of your flip book page number can be Roman and Arabic, so you can separate Table
of Content pages and Body pages.

27. Share your Flipping book via e-mails or other medium, like Facebook, Twitter, Google, Yahoo,
etc.

28. Add Single page mode to view book pages one after another.

29. Set 2 or more Languages of the tool bar for different language readers.

30. Control your Flipping book with a security setting to protect all pages or custom pages exclude
front page.

31. Google Analytics ID can help you to know your masterpiece well, as you write it in when edit
your Page Flipping book.

32. Preview the output effect instantly.

33. Powerful page edit tools:

® Link: Embed links of your company or your own Homepage, it's a way to publicize your
company and add your popularity.

®  Music: Every page can be insert in different music that in different play modes.

® Picture & Slideshow: Not only a single picture can be added into pages of your flipping

E-book, but also multi-page photo Slideshow can be embeded and pop-up to play.
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34.

35.

36.

37.

38.

39.

40.

41.

42.

43.

44,

45,

46.

47.

48.

49.

® Video: insert video in pages of your Page Flipping E-book to offer readers more vivid way
to know more information.

® YouTube: Add YouTube video related with your page flipping E-book to bring more
attention.

®  Flash: A flash added in your flipping book must make your book more animated.

® Button: Set buttons on pages to enable readers more conveniently go to webpage or get
more info when reading your masterpiece;

® Printable Area: Add printable coupons on your page flipping eBooks to make your
promotion more individual and powerful.

Define book proportions, thickness, margin size, shadow manually.

Replace existing icons on toolbar by editing Icon Flash file.

Set background color and image.

Insert background music either for continuous play (loop) or for a set duration.

Set eBook reading from right to left (for Right-to-Left languages such as Arabic).

Set Page Number Box to show at top or bottom in Float, set start page number.

Add Button on pages to open link page, call Javascript action, play Flash/Video in pop-up

Window.

Copy projects from one page to another or all the other pages.

Add password to protect your page-flipping eBook.

Different kinds of render engine for choice to avoid distortion for some special PDF files: SWF,

GPL Ghostscript or Inner Library.

Add Help config to manually define content with using Image or SWF.

Add Single/Double Page view.

Add Minime Style to show page-flipping eBooks without toolbar.

Edit bookmark manually and set bookmark or thumbnail panel to show on left or right side.

Export and save settings for future uses.

Save and Load your project.
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Page-flipping eBook features

With the page-flipping ebook you have created, your user will be able to:

10.
11.
12.
13.

14.

15.
16.
17.
18.
19.
20.

21.

22.

Click the left button of the mouse to turn pages.

Drag the corner to flip a page.

Click page shadows to flip a page.

Input password to unlock encrypted pages.

Single/Double Page view.

Pre-loading pages be opened quickly, do not need to wait all pages loaded.
Use buttons to control page, such as Previous, Next, First, Last etc.

Flip pages automatically.

View flipbook repeatedly.

View page-flipping ebook full screen.

Use thumbnail to select a page start to reading.

Add bookmark to convenient reading.

Search whole eBook.

Print out the whole ebook or a range of pages directly (support to clip area on
pages and then print).

Download the uploaded page-flipping eBook from web site directly.
Double-click to zoom in or zoom out.

Zoom in/ out both pages.

Share eBook url via email.

Share ebook via hot medium: Facebook, Google or Yahoo.

Reading the book by page-turning with sound on/off.

Open to a certain page in Browser by adding a suffix like this:
index.html?pagelndex=4.

View output page-flipping eBook on iPad, iPhone and Android devices (slide

single pages mode supported).
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Quick Start

1. Launch the application via the desktop shortcut ;

’

2. Click the "Import PDF" icon "'I:I to enter into Import PDF interface;

3. Click "% Jicon to choose PDF file from your computer;

4. Click Micon to enter into template setting interface;

5. Define parameters for eBooks, such as Book, Tool Bar, Bookmarks, and

then click the "Apply Change" icon ;

i &

=)

6. Click "Convert to Flipping Book" icon " to enter into Output

interface;

7. Choose Output Type from HTML, ZIP and EXE, here take

P o
- as example;
8. Click L Z2"=: J{5 set Output Folder as "C:\flipbook", input File Name

as "demo";

Convert

9. At last, click icon to output created page-flipping eBook.

You can open the "flipbook" folder in "C:", there are three files in this folder:

s &

files book.swf demo.html
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Open the "demo.html" file to view your created p0Oage-flipping book via Web
Browser, such as Internet Explorer, Google Chrome, Firefox, etc.

& demo - Windows Internet Explorer i)
OO "40 C\fipbook!\dema.htmd vitgl X LL'.} Bing P~

o Fevorites o
|8 demo | fi > B v 03 ep v Dagev Sefetyv Tookv @~ 7

Interfaces

There are some main interfaces you will see while using Flip PDF Pro as
below shows: Application Options, Import PDF, Template Settings, Edit
Pages, Language Option, Export Theme, Output, Batch Convert and
Command Line.

You can enter into each page to get clear instructions for every detail

option.
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Application Options Interface

1. Render Engine Option

Flip PDF provides 3 different render engines for you to create higher quality
page-flipping eBooks, click "Options->Application Options" to enter into "Render
Engine" interface:

Render Engine

Please selecte a render engine for the conversion

SV

r

SWF

(G5
GPL Ghostscript Rondoad Ghostecript

r

O [nner Lbrary

SWF: Much legble characters, smaller output size
GPL Ghostscript: Migher color transfer qualty

Inner Libcary: Faster convert speed

SWF: Much legible characters, smaller output size
GPL Ghostscript: Higher color transfer quality
Inner Library: Faster convert speed

(Change option when PDF imported failed)

2. Create Mobile Version Option

(1) Pages Quality and Size

Five types of "Pages Quality And Size" for mobile version eBooks:

Quality And Size:

i

[ Pages Quality and Size

ligher quality larg
High quality large file size
Medium quality medium file size

High values ¢ s i
but require Low quality small file size

Lower quality smaller file size

Copyright 2012 by Page-Flipping.com
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(2) Mobile Template
The current version provides two mobile template modes for you to use: Slide and

Single Page Flip. The later one adds page-flipping effect on the pages while viewing
in mobiles.

Il. Import PDF Interface

[/ Import PDF (o2Sms]

Source PDF Flie

Browse.. ] [ Openit ]

The Page Ranges to Import Watermark
) All pages UM 4 Place a custom text or image
@ Customrange: 1-10 Example:1,3,5,9-21 i ,‘7‘ Watermark(Stamp) to the file(s)
[¥] Quickly import (Only import 10 pages to initial preview) Set Watermark
Page Quality
Quality And Size: [High quality large file size v]

% High values produce better page quality but require more disk space and more time to download.

[¥] 1mport bookmark [¥] 1mport links [V¥] Enable search

Import Now

Panel Description:

1. Source PDF File:

Click this icon to open the PDF file you want to convert;

2oenit | view content of added PDF file to clarify before converting.

2. The Page Ranges to Import:

©AlPagEs oo nvert all pages to page-flipping eBook;

‘6‘ : 2-5 +1,3,9,9- H
AR s Convert defined range page;

[V] Quickly i i initi iew . .
|| Quickly import (Only import 10 pages to initial preview) Just preview effect on first 10 pages.
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3. Watermark

Set Watermark

Add

Applying Watermark

E)

Edit /
Add text stamp

Add image stamp.
Delete
Move down

d> ¢ X ¥ &

Move up

image or text watermark to flipping pages.

Check this option first to choose default stamps or add new ones:

) dd Text Watermark

% Add Text Watermark
Texthame

Mame:  Text Watermark
Text:  Page-fippng eBock

—

Macro: ®)

Text Properties

oot (@ revess )

= oo I (S
Dltake Jnderine

Embedded Font

ste: [jeog
Text Layout
oot o] V] 43 badaround
[lig sty 2.9

Positon nmargns  Margine
v o Ysen

Left: 20

Page-flipping eBook

|« = uf
=[5 =
Text Effect
Ogadty: 0% i
y Rotaton: 0 2
Metric units
|inches.

k| Add image Watermark:

2 Add Image Watermark
Image Name:
tome:  Image Wotermark

Image Propertes
Width: 0

& beght %

~I5tretch to margns g

1 100%

= LA
it to

e

Image Effect

Opacty: 0%

Rotaton: 0 + degree 7] &s background

Postoninmargns  Margns
W« W«

o = u
=[] =
Unt

[ameirs

X3

4. Page Quality
There are five types of "Quality And Size":

Medium quality medium file size
Low quality small file size
Lower quality smaller file size

5. Other Options:

[#] import bookmark If your PDF file contains bookmarks, check this option to use in output

page-flipping eBook;

V| import links If your PDF file has links, check this to enable in flipbook;

Copyright 2012 by Page-Flipping.com
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[V|Enable search Check this option to enable search functionality in created flipbook.

V| Detect wide pages  cpack this option to make landscape page in PDF file to be presented as

two-page spread in output flipbook.

At last, click icon to enter into template setting interface.

lll. Template Settings Interface

e D phrem O W gamen - (41 o Lot
T . St
D) AOd4EN>>re 7?20
g -l
Fwene st w Te e ey e
o e wwe
7% b
The b Lage P e
[
(I owe bo
Do Bt
Aot B w——
S
S S —
Drwe oty
-y At e
L
Ot Cony
- .-
St dewnet Te
P ]
Tamr e (- ~
Dt
[
Trwton Sonrd L g
vt
bord g
31
ER o e On Soow s 1

Flip PDF Professional provides 4 different templates in the program: Classical, Float, Neat
and Spread. Each template contains some unique settings, the below instructions will show
you details about the default three templates.

The design setting interface contains below main parts:
Choose Template, Tool Bars Settings, Flash Display Settings and Flash Control Settings.

1. Choose Template
Templates

‘ If classical ’H E

Please customise the flash template here

i Classical ’H

icon to select templates from below interface:
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l&) Select 2 Template L_‘Elﬁ
' Choose a flipbook template here. (Double-dlick to make a quick selection)
B (More and more templates will be provided in future.)
r Get More Themes Online
Newly developed Neat Template provides a stylish and fresh look for you to design more stunning page-fiipping eBooks. In Neat
Template, you can add brand logo in the top toolbar, set different featured buttons, show or hide transparent thumbnails at bottom,
enable Social Share via different channels, etc. Neat presentation interface, neat control panels and neat reading manner help to build
your neat feeling publications.
Templates =
™ Classcal || pe——coesssea 00—
| (1] Fioat soe, 9
£l
[EI Neat ‘
[i®| spread ==L 1
E Calendar Black Pattern Blank Light Shadow
D Conciseness
D Lively (™ 2 . 1=
2 N
- Pl | BT
i SingleSlide # - .
o =~
Il . A
b
Official Blue Official Red Romantic Pink
| ‘ =
' [ Refresh ] [ Remove The Template ] [ Remove The Theme ] Remove functions needs Addministrator rights! J
= = = =4

Download more themes from PageFlipping now:

http://www.PageFlipping.com/templates-themes/index.html .

Q Click this icon is to save current settings as a TXT file for later uses;

“'- ] \ . . . . . . .
==J  Click this icon is to import stored setting file at once.

2. Tool Bar Settings

EITooI Bar Settings
Title Bar
Buttons Bar

Tool Bar on top iFalse

Add Icons Settings
EButton Icons

(1) Title Bar (only in Float template)

ElTitle Bar _
The Book Logo |C:\Users\Admini...
Logo URL http: //fiipbuilder...
Book Title <a href="http://...

Page Number Box On ... |False

{y FLIPBUILDER.COM |

Customize book title and logo for showing on the top of your flipbook. You are enabled to

set the book title as HTML format text. For example: <a href="http://www.PageFlipping.com'
target='_blank'>PAGEFLIPPING.COM</a> | <font color="#ff0000' size='14">Red Color</font>

Copyright 2012 by Page-Flipping.com
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(2) Buttons Bar

[EButtons Bar

[FHHome Button

[ About Button |
Full Screen Button |Show

[HHelp Config

[HPrint Config

[HDownload setting

[HSound

[HZoom Config

[HSearch

[HShare

[HAuto Flip |
Thumbnail Button |Enable

[HSingle Page

[HLanguage

i. Home Button

You can add a home buttonm to help reader to click and go to your website directly:

[ElHome Button
Home Button Visble ~ |Show
Page URL |http://flipbuil...
Open Window |Blank

ii. About Button

Add About button to show the author, contact, book, company info:

[E About Button ‘
About Button Visible |Show
Content | <textformat _I

Click "..." to enter into "About & Contact" edit interface:

About & Contact Settings

Flip PDF Professional DemoBook
Presents powerful features in the Flash digital eBook, such as social share, print, autoplay
etc.

Contact us at: alice @flipbuilder.com
http://flipbuilder.com

K Clear
Q Save As..
(3] Load..
& Demo

hyperlinks and so on.
More details about tags please: Click Here

You can use some “tags” to format the text shown in the "About & Contact” window, such as text font, font color,

[ ox

]

I

Cancel l

After clicking the About button, you will view the About window by clicking the button:

Copyright 2012 by Page-Flipping.com
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{, About & Contact x

Flip PDF Professional DemoBook

Presents powerful features in the Flash digital eBook. such as social share, print.
autoplay etc.

Contact us at: alice@flipbuilder.com

http:/flipbuilder.com

iii. Full Screen Button

To enable "Full Screen" functionality in output flipbook, select "Show" in "Full Screen
Button" option: Full Screen Button Show

[
. . D . . . . . n n
Then you can click icon to view flipbook in Full Screen, click icon m or "Esc

button to exit from the Full Screen.

Or if you want to show your flipbook without Tool Bar while showing in Full Screen mode,

you can set "No" in "Full Screen without Tool Bar" (just in Classical Template):
Full Screen Without Tool...|Yes

iv. Help Config

EHelp Config
Help Button Show
Help Content File -type.png |
Help Window Width 400
Help Window Height 450
Show Help At First Show

To show tips about viewing flipbook, you can set "Show" in "Help Button" option, and you
can define Help Content manually by inserting "Help Content File (image or SWF)", also
enable to define the Width and Height of the Help image or swf. If you set "Book->Retain the
book to center->No", you can set "Show Help At First->Show" to display the Help Panel with
the Book as below:

Copyright 2012 by Page-Flipping.com
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Dowble-ciick to 200m in/ro0m out,
Orog the poge Comer o
Use mouse whee! 10 flp poges.

You can also click the button to view the same Help page in pop-up window.

v. Print Config

ElPrint Config
Print Enable |Yes

Print Wartermark File |FEEyEreRaae

Choose "Yes" in "Print Enable", then click icon to set print page range as below:

& Pnnt *

=) Print Al Pages
() Print Current Page

\) Print Range

Example; 2,5,8-26

& Print

L 4

You can also click "Print Watermark File->..." button to choose image or SWF file from your
computer as watermark on printed out pages.

vi. Download Setting

 EDownload setting
Download Enable |Yes |
I Download URL |>DFDemo. pdf !

If you want your flipbook readers to download the PDF file or the flipbook directly from your
website, select "Yes" in "Download Enable" option, then input the Download URL directly,
you can use absolute path like
"http://www.PageFlipping.com/flip-pdf/example/files/download/FlipPDFDemo.pdf" or
relative path like "/files/download/FlipPDFDemo.pdf" (make sure you have uploaded the
Copyright 2012 by Page-Flipping.com
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PDF to the same path).

Then readers can click the icon n to download your uploaded PDF file directly.

vii. Sound

ElSound ‘
Enable Sound Enable !

| SoundFie rples.mp |
Sound Loops % ‘

If you want to add background sound to your flipbook, such as a song or other audio file, set
"Enable Sound->Enable", then click " =|" icon to choose "Sound File" from your computer,
then set "Sound Loops", "-1" stands for playing the sound file all the time while viewing
flipbook, other value (N>0) stands for the times of playing the sound file.

viii. Zoom Config

ElZoom Config
Zoom in enable Yes
Zoom Scale 1.5

To Enable Zoon In functionality, choose "Yes" in "Zoon in enable", then set "Zoom Scale", the
value is the times between zoomed page size and the current page size.

In Float template, you don't need to set Zoom Scale, you can adjust more conveniently by

the zoom in tool like this: m You can also set "Scroll

with mouse->Yes" to scroll zoom in page while moving mouse.

ix. Search

Search Button Show
Search Highlight Color [JoxFFFF80
Least search characters |3

Select "Show" in "Search Button" (make sure you have check "Enable Search" option in
"Import PDF" interface), then define "Search Highlight Color", after clicking "Search" icon

Copyright 2012 by Page-Flipping.com
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, you will see a popup box to input search words, then click Enter or "Search" button,

you will get the below searching result:

x. Share

s R
L e s
Sodial Share Button | Show

You can share via emails, or just through Facebook, Twitter, Google, etc..

a. Share Button
If you want readers to share via Email, you can enable "Share" feature as below shows:

_BshareButton |

... ShareButton ~ |Show

. Email Subject ~ Rear my fi...
Email Body flink}

When the viewers click the share button E, they will enter into the Email interface with

the link of your flipbook in the Email body.

b. Social Share
If you want your flipbook viewers to send the link to their friends or clients via Facebook,
Twitter, Linkedin, Google, Yahoo and so on, you can add a Social Share button in your

flipbook for readers to send out your flipbook link immediately:
l Social Share Button [Show |

The readers just need to click the "Social Share" button m, then the below window will pop

up for them to choose share channel:

Copyright 2012 by Page-Flipping.com
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xi. Auto Flip

To auto flip your eBooks, you can set "Yes" in "Auto Flip->Enable" option; then define the
Flip Interval (seconds of staying on each page); the value of "Play Count" stands for the times
of auto playing the eBook, and "-1" stands for playing forever (after clicking the Auto Flip

button “, the flipbooks will be flipped by staying 3 seconds per page); if you want to

auto start and flip the eBook after opening, just set "Auto flip when start up->Yes":

EAuto Flip
Enable Yes
Flip Interval 3
Play Count -1

Auto flip when startup |Yes

xii. Thumbnail Button

| Thumbnail Button Enable

Show Thumbnail Button ﬁ(set "Enable") to view page thumbnails of your book, or you can
Disable it to hide the button.

xiii. Single Page

[ single Page |Enable |

If your book contains landscape pages, or the page content is different to read for the font is too

small, you can set "Single Page->Enable" to enable readers to click "Single Page" icon n to

view pages one after another, then click "Double Page" icon m to back to the normal book

reading mode.

xiv. Language

[ElLanguage English .
I Language English;Ching _J
Switchable |Yes
You can set language for showing tools or tips in your created flipbook, click "..." to enter into

"Language Settings" interface. You can choose two or more language to use, just check

"Switchable" option, then users can click "Switch Language" button E_Jto choose their

prefer language for tips (more language setting details you can view in below Language
Setting part):

Copyright 2012 by Page-Flipping.com
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Please select a language below...

English

French

(3) Tool Bar on Top (only in Float template)
If you want to place the toolbar in Float templates on the top of the flash eBook, you can set
"Tool Bar on Top" as "True":

Tool Bar on top True

(4) Add Icons Settings
If you want to add some other kinds of buttons which the program doesn't provide, you can click
"Add Icons Settings->..." to enter into "Icons Settings" interface to add new icons on tool bar:

Copyright 2012 by Page-Flipping.com
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Add Icons Settngs
B/ Icons Settings

[ Config icons for toolbar
Xgemwem A Clear @Mmew @Mwenom ‘
Caoo Acton Type _ Action Content
) Jcon Setting: TTT— |
Add Tcon i
Icon Fie
Source Fle:  C:'\Users\Adminstrator \DesktopWew foidermage: | Erowse,.. . OE!'\ ; ‘
Button Info
Cagion: GoToPage 6
Teon Button Acten
9 Go to page Open a bk Cal Javascript function
PageIndex: 6

Go To Page 6

O 7 # <@ Q@ Q = {§ > w

(o J [ gmoes

You can define the link action as "Go to page", or open an online webpage, or even "Call

Javascript function" to carry out your wanted interactive functionalities via defining Javascript
function yourself.. After your "Apply Change", the new added icon will show in the toolbar. (More
details about Call Javascript function will be introduced in the part of "Edit Page->Add Link".)

(5) Button Icons
Define settings for the icons of the buttons:

[EButton Icons
Icon Color | CJoxffef
Icons File(SWF Only)

i. Icon Color

Icon Color

| JoxFFFFL=]
7?7 Q ~ = Q

ii. Icon File
Select the Tool Bar Button to replace with your own icon.
[ Icons File(SWF Only) [c:\users...

More details please view here:

http://www.PageFlipping.com/support/how-to-replace-icons-on-flash-toolbar.htm

Copyright 2012 by Page-Flipping.com
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3. Flash Display Settings

ElFlash Display Settings
Retain the book to center |Yes
Font
Initial Show None
Show Corner Flip Effect  |False
[HBackground Config
Flash Window Color | Eoxafa0ab
Page Background Color | [(JOxffffff
Book Proportions ‘
Book Maragins
[HPage Shadow
Hide Book Frame Bar No
Right To Left No
Hard Cover No
Flipping Time 0.6
Page Number
Minime Style

(1) Retain the book to center
| Retain the book to center |Yes ~]

If you select “No” in this option, the eBook will be shown on the right-side. This setting is for
embedding special background image, such as advertisement or company log.

(2) Pages per thickness (only in Neat template)

To create more real life like ebook, you can set Pages per thickness, which means how many
pages to show a distinguishable thickness. The smaller value set, the thicker your book. If the
value is smaller than 0, or larger than the total page number of your book, it won't show any
thickness. And on the book edge, you will see different page number tips for you to click and go
to that page directly:

AN QHMAENE) e 7?20

A Tunteas 0 Sna 00 sacal o i

(3) Font

ElFont
ElButtons ‘
Font Color [CJoxfffeef
Button Font Tahoma
Title and Windows
Bookmark
Search

Change fonts of toolbar buttons, flash windows even bookmarks or search result panel.
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(4) Initial Show (set in Float/ Spread templates)
You can show Bookmark panel or Thumbnails panel on the flash page at the beginning, just
select "Bookmark" or "Thumbnails" in this option:

For Example, select "Thumbnails": [ it how [Thumbnaik v|

Then you will get flipbook shown with below initial interface:

(5) Background Config

i. Background Color:

BBackground Config
El8ackground Color
Gradent Color A Doxrreeer |
Gradent Color B 0000000
Gradent Andle 90

Gradient Color A

Gradient Color B

Define background for your flipbook with gradient color or pure color (the same color for
"Gradient Color A" and "Gradient Color B"). Gradient Angle is the angle between two colors.
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ii. Background Image (set in Classical and Spread templates):

ElBackground Image
| Image File
Imaqe position

Click the icon " =" to choose background image from your computer, and there are 11 kinds
of "Image Position" for you to choose: Scale to fit, Fill, Top Left, Top Center, Top Right,
Middle Left, Middle Center, Middle Right, Bottom Left, Bottom Center and Bottom Right.

iii. Background Image (set in Float template):

B8aduground Imace
Outer Image Fie E: Program. .|
Image posibon Scale to fit
Linner image Fle £: Program.. |
Image position ‘Scale to £2

The Float template enables you to add two background images: Outer Image and Inner
Image. You can make Inner background image to show special information, such as
advertisement or company logo, etc. There are also 11 kinds of "Image Position" for you to
choose: Scale to fit, Fill, Top Left, Top Center, Top Right, Middle Left, Middle Center, Middle
Right, Bottom Left, Bottom Center and Bottom Right.
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(6) Flash Window Color

| Flash Window Color

M 0x0000]

This color will be applied on all flash windows, such as the book window, "Help" window,
"Print" window and so on.

(7) Page Background Color

When load pages, or if the page number of your PDF file is odd, then the page (the last page)
will show with the "Page Background Color".

(8) Book Proportions

Bl80ok Proper bons
Page Wit w2
Page Height 1500

Please note that the values are not fixed in pixels or inches, they represent a ratio of "Page
Width: Page Height", and the book size will be adjusted with your Explorer Window Size.
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(9) Book Margins

i. Book Margin (set in Classical Template):

Rgpe Toleft Yes

"Book Margin" refers to the distance between the book and the toolbar.

ii. Top/ Bottom/ Left/ Right Margin (set in Float/ Spread Template):

=3

Bottom 4

(10) Page Shadow

ElPage Shadow
Left page Shadow
Right page Shadow
Page Shadow Opacity
Lefe page Shadow

50
25
0.5

Right page Shadow

The value also takes the value of Book Proportions as reference, and the value interval of
"Page Shadow Opacity" is "0~1", the larger value refers to the deeper shadow color.

(11) Hide Book Frame Bar

|  HideBook FrameBar |Yes ~|

If don’t want to show the book frame bar, choose “Yes” in this option.
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(12) Right to Left

If the language of your file is read from right to left (such as Arabic), then choose "Yes" in
"Right to Left" option:

Rt Toleht Yesu

Vg Py TIV e
Next P.uqci {

(13) Hard Cover

If you want create hard cover effect (a book bound with rigid protective covers) for your
flipbook, choose "Yes" in "Hard Cover" option:

Hard Cover Yes

(14) Flipping time
Flipping Time 0.6

Sets page flipping time in seconds according to your needs. (Recommended value is 0.6)

(15) Page Number

If you don't want to count in the cover page, table of contents pages into the actual page
numbers, you can set "Start Page Numbering (Roman)" and "Start Page Numbering (Arabic)".
For example, the first 3 pages are Table of Content pages with Roman page numbers, and
set Arabic page numbers from page 4, then you will get page number box like below:
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EPage Number
Start Page Number (Roman) |0
Start Page Number (Arabic) |3

Front Cover Page:

Pages: 1/8

The Fourth and Fifth Pages:

(16) Minime Style

If you want to present Page-flipping eBook pages directly without showing toolbar, especially
when you want to embed eBook into a small area in existing webpages, then you can use this
"Minime Style".

The Minime Style will trigger when the Width or Height of the Flash Container is less than the
defined value. You can also always show the page-flipping eBook in Minime Style with adding a
parameter to your URL like this: www.yourdomain.com/index.html?alwaysMinimeStyle=true .

EIMinime Style |
Use Minime Style Yes
Width 400
Height 300

4. Flash Control Settings

[EFlash Control Settings ‘
Security Settings |No Security
EHLinks
Google Analytics ID

(1). Security Settings

| Security Settings Single Pass |
If you want to protect your flash books with passwords, you can click "..." icon to enter into

"Flash Security Config" interface:
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Note:
Single Password option maans that users nead tha password 1o view the fash book.

Exclude Front Pages option is 10 set a page number, all latter pages can't be
viewed without inputting password,

Secunty Type

a

_ o Seaurity

9 Sngle Password: 123456

Protect Page Range
AIPages

® Excude Front Pages 0

Lo J [om

Select "Security Type->Single Password", and input passwords into the box (there is no
restriction on password format at present). You can also set "Protect Page Range" as "All
Pages" or the latter pages after a defined page number. (Tips: The program utilize RC4
algorithm to protect eBook pages, the eBook content pages will show nothing without

permission.)

(2). Links

If you have check "Import links" option in "Import PDF" interface, or add links in "Edit Page"
interface, then you can define settings here, choose "Mouse over color", "Link alpha" (refers
to the link area opacity, value interval: 0~1, "0" stands for the area is totally transparent),
and "Open Window->Blank/ Self". The links also can be clicked after zooming by setting

"Enable after Zooming in->Enable".
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(3). Google Analytics

Google Analytics ID

In the HTML output format, you can add statistics by using google analytics. You can get
more information about Google Analytics ID from http://www.google.com/analytics/ .

Besides, Export Theme

If you want to save the current template settings as your own style template for later uses,
you can click "File->Export current settings as Theme" button to storing all current template
settings, include the background images, margin values, toolbar buttons and so on.

Then when you want to use later, just click "File->Import Themes", the theme will be added
to the templates selecting interface.

Download more themes from PageFlipping now:
http://www.PageFlipping.com/templates-themes/index.html .

(Al Apply Change
After setting template and language, click icon to apply the settings.

IV. Edit Pages

Use Flip PDF Pro to edit imported pages directly, no matter you want to add link, video, sound or

=) >
{ Edit Pages
=] ™, Q!

image file. Click "Edit Pages" button to enter into page edit interface:
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1. Add Link

Click the icon and then draw a link box on the area you want to add link, then define

properties in below panel:

Link Properties

© Down ® Up ® Move

® Over ® Out
over Color: [ Over Alpha:

Down Color: Down Alpha:

Normal Color: Normal Alpha: ® Go to page  Openalink ® Call Javascript function

® Open Flash Window @ Play Audio ® Photo Slideshow

URL:

ok "onel

You can define the link action as "Go to page", or open an online webpage, or even "Call
Javascript function" to carry out your wanted interactive functionalities via defining Javascript
function yourself.. For example, you can show a pop-up light box while readers clicking some
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image on page, or pop-up a questionnaire or other Web Form by clicking some text. Just make
sure the parameter you set in "Function" can be called in from HTML page.

Example: Check "Call Javascript function" as action type, then input Function as
"testLightBox("Hello, this is a test"):

® Down © Up ™ Move

® Over ® Out

® Go to page ™ Openalink © Call Javascript function

Function:

And then make sure the Javascript wrote into the index.html page as below image shows (the
same as you set in "Link Function"):

<head>
<title>PDF-BenU brochure 2010-100dpi</title>
<meta http-equiv="Content-Type" content="text/html; charset=utf-g8" />
<meta name="Keywords" content="" />
<meta name="Descriptiocn" content="" />
<meta name="Generator" content="[Flip PDF version 3.0] at http://flipbuilder.com/" />

<style type="text/css"” media="screen">
html, bedy { height:100%; }
body { margin:0; padding:0; overflow:auto; text-align:center;
background-color: #Lfffff; )
#flashContent { display:none; }
</style>

<script type="text/javascript™>

3
.'[ function tesr.Lighthﬂst:rEromFlash) {
e =

want here

alert(strFromFlash);
}

</script>

2. Add Movie
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Click icon and then draw a box like below on the page you want to insert FLV movie:

Then you can select and edit the movie in below panel (define video player skin color, play and
stop movie actions, etc.):

Movie Properties

Select FLV Movie

Player Skin Color:

Play Movie: When click Play button

2 When diick Play button
Stop Movie:

When enter the page

When leave the page

H:

[ W
[ L |

3. Add Image

Click the icon E to draw image box and then select image (.jpg, .png, .bmp), set Action

Options (the same as Link Action Options):

Image Properties Action Options

. Action Option§ © Down ® Up ® Move

® Over ® Out

' Select an mﬁgé

® Go to page © Openalink ® Call Javascript function
® Open Flash Wndow @ Play Audio ® Photo Sideshow

URL:

------- ®

4. Add Sound

Click the icon ' to draw sound box and then select sound file, set other options:
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Sound Properties

Play Sound: [

Stop Sound:

5. Add Flash

Click icon . to insert SWF flash into your defined area of flipbook page:

6. Add Button

T

Click icon . to draw an area for inserting your image or SWF button file with calling actions.
The actions contain "Go to page", "Open a link", "Call Javascript function"” and "Open Flash
Window". The before three actions are the same with the actions in "Add Link", the "Open Flash

Window" can help you to play SWF Flash or FLV Video in the pop-up window:
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-
Button Properties Open Window Action Properties X

Select an Icon(SVF,Image) WLEEIBVEEE  open the window to play a video
Window Content: Select The File

Button
Action Options

[ Action Options

Window Caption:

~ - -
Bown Up poie Window Width: Window Height:

m Cancel

® Over ® Out

® Go topage ® Open3aink ® Call Javascript function

© Open Flash Window

m Cancel

7. Add You Tube Video

 You |
Click the icon and then draw a box on the page to insert You Tube video into pages directly.

You just need to define the video ID directly. For example the video link is:
http://www.youtube.com/watch?v=xKA6W!IqjB7c, then the video ID is " xKA6WIqjB7c".

YouTube Video Properties

Video ID:

Video Parameters:

Play Movie: When click Play button

When dlick Play button

Stop Movie:
When enter the page

When leave the page

H:

8. Add Printable Area
If you want readers can click on some area of your book to print the area directly, such as
coupons which can be used to buy your presented goods, you can add a "Printable Area" on

L
pages by clicking the icon , and then draw the area on the pages, set title and description:
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Link Properties

Color: B over Alpha:

Border Color: Border Width:

Title:

Description:

9. Copy and Paste
If you want to add same links, images, videos, audios to different pages, you don't have to repeat
the "Link/Image/Video/Audio added" operations once and once again, just select the link object,

click the copy button and then go to the other page to click the paste button mdirectly.

10. Apply All
If you want to use the same link, video, audio, image or button on all pages (or all odd, even
pages, or your customized pages), you can select the object and then click the Apply All button

)
, then define the apply page range in pop-up window like below:

Page Ranges

™ AllPages ™ 0Odd Pages ™ Even Pages

® Custom range:

After adding links, flash, movie or sounds, you can click the icon to save the settings and

back to the template setting interface.

V. Language Options Interface

Click "Option->Flash Language" or "..." button beside Language setting part, you will enter
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into the Language Settings interface as below shows:

& I;anguage Settings

You can edit current language file or add a new language to display your page-flipping eBook, two or more languages can be
used at the same time. Readers then can dlick "Change Language " button to view the eBook in their prefer language.

The first checked language on the top of the "Languages” list will be taken as the default language to show your fiip book. You

¢-X@@A‘

v can also define a language to the published flipping-book by specifying with the address like:
http: /fwww.somedomain.com/mybook.html?pageIndex=4&lang=1apanese

Lauangues I

English Q Save as... 3y Load... | Edit |

Chinese Language Settings

[] Arabic

[ French Label l Labeled -
First Button First

[ German Next Page Button Next Page

[] Gresk Last Button Last =
Previous Page Button Previous Page

[ Hebrew Download Button Download

] Italian Print Button Print
Search Button Search

[] Japanese Book Mark Button Book Mark

[ Portugues Help Button Help
Enable FullScreen Button Enable FullScreen
Disable FullScreen Button Disable FullScreen
Sound On Button Sound On
Sound Off Button Sound Off
Share Button Share
Social Share Button Social Share
Zoom In Button Zoom In
Zoom Out Button Zoom Out
Auto Flip Button Auto Flip i

Panel Description:

As the tips explaining, the "Labeled" column lists the buttons and instructions on Flash books
in defined language, and the program provides you 10 different languages for you to use:
English, Chinese, Arabic, French, German, Greek, Hebrew, Italian, Japanese and Portuguese.

You can also add other language for your own uses:

1. Click the button % and define name for the new language:

L)

.J New Language
New Language

Name: French

Copy From: Engish -'J

Lo ) [ come

2. Choose the first label and click "Edit" icon, define new language text in "Labeled" box,
then click "Save And Edit Next":
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Next Page Button

Last Button Last fi Edti Language Item
Previous Page Button Previous P& EatL, Strng T
Downioad Button Donnload . {
Print Button Print
Search Button Search Lbel:  FrstButton
Book Mark Button Book Mark
Help Button Help Labeled:  Premire|
Enable FullScreen Button Enable Fulls
Disable FullScreen Button Desable Ful

| Savnd P B tan Srend On |

|_seve andestnext | |

oK

=

3. At last, you can get all Labels translated into your new language as the images shows:

Label

First Button

Next Page Button

Last Button

Previous Page Button
Download Button

Print Button

Search Button

Book Mark Button

Help Button

Enable FullScreen Button

Disable FullScreen Button
CanimAd Nin Bidban

Labled

Premiére

Page suivante
Derniére

Page précédente
Télécharger
Imprimer
Rechercher
Réservez Mark
Aide

Activer FullScreen

Désactiver FullScreen
la CatimAd

% Delete
You can delete unwanted language:

Or save your edited new language file as XML or TXT file:

33 Load...
Load language file saving before for current using:

(o |

After setting template and language, click

apply the settings.

Apply Change
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VI. Output Interface

ﬁ Output Option @
Output I

Output type

/ - N < B -

a @ =html © =zp {:@2& O *exe ‘, o =.app
- ’éu J
Also Make Mobile Version Make output page-flipping eBook works on iPad, iPhone and Android mobile devices

Path

File Name: index .html
Options

HTML Title: demo

[]Burn to CD

Make it automatically play the flipbook in CD

Output Folder: C:\Users\Administrator\Desktop\flipbook

ter |0:1:0,G: PLDS DVD-ROM DH-16D55 VD15

[ Browse... H Open l

[ Cancel I [ Convert

Output types:

1. HTML

P @-am

This output type is for uploading created page-flipping ebook onto websites:

You can define HTML Title and other properties by clicking "Advanced" button:

Options

HTML Title: demo

Set Keywords, Description or even Script in the below interface:
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[g] Advanced Settings ]

HTML Advanced Settings

HTML Meta Settings

Title: demo

Keywords:  pdf, flipbook, page-fipping, ebook, online, website, flash, background, music

Description: [his page-fipping eBook shows you the stunning flash effect on PDF pages, a

Add Scripts
You can put some tracking
code such as Google
Analytics here,
Need dosed <saipt>tag!
I
2.ZIP

This output type is for compressing the created files into an integral ZIP package which can
be sending out as attachment directly. You can also define HTML Advanced Settings by

clicking "Advanced" icon:

Your recipients just need to uncompress the ZIP file and then they can view the HTML
flipbook instantly:

, files
('/ demo.html

book.swf

Uncompress

3. EXE

This type is for outputting flipbook as a single executive file, easy storing and easy viewing:

‘
| Fi
I demo.exe ]

You can also define Icon and Opening Window Size in Advanced Settings:
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1:,9

-

-U Advanced Settings @‘

Exe Advanced Settings
Exe Window Info

Caption: demo
tcon: TR | o | [ pefout
Window Size Option

Maxmized Custom Size

9 Full Soreen

o) (o

If you want to make executable application to run on Mac devices, you can output as
"* app" format.

5. Mobile Version
(V] Also Make Mobile Version

You can even output Mobile Version while choosing HTML or ZIP format at the same time.
After creating mobile versions, you just need to output all files online (including HTML, SWF,

"files" and "mobile" folders), then you can visit the flipbook page through your mobile
browser.

6. Burn to CD

[¥]Burn to CD

CD Writer | 0:1:0,G: PLDS  DVD-ROM DH-16D5S VD15 ¥

Disc title: Page-Flipping eBook

[¥] Make it automatically play the flipbook in CD

After choosing output type, then check the option "Burn to CD", set "CD Writer", define
"Disc title".

How to make created eBooks available for others online, more details this support page:
http://PageFlipping.com/support/how-can-i-share-my-created-ebook-online.htm .

At last click lM]button to output flipbook in your defined type.
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VIl. Upload Online
7"%}‘—
After designing your book style, you can click "Upload Online" button !_E”Mto

upload your

book onto PageFlipping website server

directly. Upload the books to

PageFlipping.com server, just need 4 steps: Register, Receive login username and password, login

your account, upload your books.
TR T T W e

&) Login

Upload the books to FlipBuilder.com server, just need
following steps:

1. Register
2. Receive login username and password;

3. Login your account;

- 4, Upload your books.

More details about hosting books onto FlipBuilder.com, dick Here

You must login before you can upload...

() If you have an account

Remember the password

Auto login

@ Apply for a new account (Registration)

2 Register |

1. Register

Click Register button in the program to build your account in PageFlipping. Enter into

http://panel.PageFlipping.com/chargeback/registered.php to create ID, as below interface shows:

Create an ID

simple steps, you can

er successfulyt We wil not

your nformation with anyone

eise unless you authorze us to do 0.

Registration Process:

Create an ID

Choose an ID and user name.

Input your Email, User Name (which will be a part of the final book online URL, like

http://online.PageFlipping.com/PageFlipping/demebook/index.html, "PageFlipping" is your User

Name, and "demobook" is the Book name.), read Terms of Service, if agree, then click

"Subscribe" button to enter into PayPal interface, login and prepare to pay for the service from

the secondary month, because first month free, and you can stop the service at any time you
Copyright 2012 by Page-Flipping.com

-41-


http://panel.flipbuilder.com/chargeback/registered.php

|:EI

w5
e

\/;_\, PDF to Professional Page-Flipping eBook Utility
: User Document

want.

2. Receive Login Username and Password

Once you confirm and process the final payment on the PayPal web site, you will receive your
Payment Receipt, Registration Information, Rental Information in your email box which you set
while building your own account. And PayPal will charge your account periodically, and all of the
paying info will be sent to your email box instantly.

3. Login Account

Back to Flip PDF Pro program, then select "If you have an account", input your Email and
Password to login.

4. Upload Your Book

After login your account, you will access into "Config the book" window to upload your just
created book:

I&] Config the book o [ |
L — ——
Book settings |
HTML Meta Settings
Title: PDF to Flip Book
Keywords: page-flipping, ebook, publish, online, thinkness, sound, image, design, template, theme

Description: convert pdf to page-flipping ebooks to publish online easily, with background image, sound, book thickness effect added

Add Scripts

<script type="textfjavascript™>
ffput your javascript code belowe
<fscript>

You can put some tracking
code such as Google
Analytics here,

Need dosed<script>tag!
[7] Also Make Mobile Version Make output page-flipping eBook works on iPad, iPhone and Android mobile devices
Book
Firefox v
*) Override an existed book
" Demo Book of Online x
Book name: 2012-Febrary *
6 ) http:/online flipbuilder.com/fi =r/[demoBook/index.html
N =

The book name will be a part of the final online URL, so you'd best make the

v =
eris the User Name demoBook is the Book Name
names unique and different.

You can set HTML metadata, like Title, Keywords, Description and Scripts. Check "Also Make
Mobile Version" or not, set Book Name, which will be a part of the final book online URL, like
http://online.PageFlipping.com/PageFlipping/demebook/index.html, "PageFlipping" is your
User Name, and "demobook" is the Book name.

Click "OK" at last, your book will be published right away. You can use the Book URL to share
with others online, or through social share websites, or copy the Embed Code to insert into
webpages, etc.

More FAQs about Upload Service: http://panel.PageFlipping.com/userLoad/fag.php
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VIll. Batch Convert Interface

[g] Batch Convert

) Add PDF Documents

|| s addFies s Add Eolder e 5 Clear Al

Name Path

JLFlip Printer E:\Useful Documents\PDFs Flip Printer.pdf
J~Flip POF E:\Useful Documents\PDFs\Flip PDF.pdf
J:Flip Word E:\Useful Documents\PDFs\Fiip Word.pdf
JFip PPT E:\Useful Documents\PDFs\Fiip PPT.pdf
) Settings

Output Settings | PDF Settings |

Output type

P oo

Path

Output Folder: C:\Jsers\Administrator\Desktop \fiipbook

File Name: {PDF FileName} v html
Fiip Printer
Options
HTML Title: My FlipBook 5
My FlipBook

[] Merge All PDF Files to One FlipBook

) Convert to Flash

J) converttoftash

1. Add PDF Documents

s Add Fies ‘

Click this icon to add PDF files from computer;

‘M1 Click this icon to add all PDF files in the folder (include sub-folders).

You can also remove some unwanted PDF, move up/ down files, or clear all documents.

X Remove % Clear All @ Move Up @ Move Down

2. Settings

(1). Output Settings

i. Choose Output Type

Output type

[¥] Also Make Mobile Version  Make output page-fiipping eBook works on iPad, iPhone and Android mobile devices

ii. Choose Output Path

Path

Output Folder: C:\Users\Administrator\Desktop [ Browse... ][ Open ]
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You can also define output name pattern with FileName, Title, Subject and so on:

File Name: {PDF FileName} | E]

{PDF Title}
{PDF Subject}
DF Author

oD

And after defining the File Name, you can preview the result example below:
File Name: {PDF FileName} Flipping Book +

Flip PDF Flipping Book

iii. Define Output Option
Options
Caption:  {PDF FileName} v \§ Advanced
Flip PDF

Click "Advanced" icon to define Keywords, Description for HTML flipbooks, or define Icon,
Window Size for EXE flipbooks:

U Advanced Settings ﬂ U Advanced Settings m
HTML Advanced Settngs | [ £xe Advanced settngs ' |
HTML Meta Settngs Exe Window Info
Tite: demo Capton:
Keywords: 0¥, fiobook, page-flopng, ebook, online, website, fash, badground, music
| ] |
fffffffff Teon: foult
Descroton: s page-Aopng €800k shows you the stunning fash effect on POF pages, 8 ap Lo L0 J
Add Sarots Window Size Optien
You can put some tradkng Maxmized Cystom Size
code such a5 Google
Analytcs here.
Need dosed <saript>tag 9 ful Screen
; |
e ) [omn oot ] |

iv. Merge All PDF Files to One Flip Book

[¥]Merge All PDF Files to One FlipBook:

(2). PDF Settings

i. Page Range

The Page Ranges to Import

") All pages

Example:1,9-21,30

You can convert "All pages" or just "Custom range";

Copyright 2012 by Page-Flipping.com
-44 -



= s

PDF to Professional Page-Flipping eBook Utility

User Document

ii. Watermark
Watermark

o & Place a custom text or image
” Watermark(Stamp) to the file(s)

=

Click "Set Watermark" icon to enter into "Watermark" interface:

Option -

i

Watermark

V] Applying Watermark

Watermark Name

[T A Text -FinaL

[7] A Text - COMPLETED

[7] A Text-DRAFT

| 7] A Text - FOR PUBLIC RELEASE
il ] A Text - INFORMATION ONLY
[] A Text - NOT FOR PUBLIC RELEASE
[71 A Text - NOT APPROVED

)| [F] A Text - Company(Tie)

[7] A Text -LOGO (eft-top)

[ A Text -LOGO (Right-Top)

[71 A Text -LOGO (Left-Bottom)
[] A Text -LOGO (Right-Bottom)
[7] A Text - Dynamic - (tite)

[7] = tmage - LOGO

Type

Text
Text
Text
Text
Text
Text
Text
Text
Text
Text
Text
Text
Text
Image

2R Text - CONFIDENTIAL Text

m

i)

P ¢ X ¥ &

[ o

]

| Gancel

1

|

Check "Applying Watermark" option, then you can choose default stamps, Edit them, or Add
Text Watermark, Add Image Watermark, Delete, Move Down/ Up.

iii. Page Quality

Higher quality larger file size

Medium guality medium file size
Low quality small file size
Lower quality smaller file size

Choose quality and size type from listed five kinds.

iv. Other Options

Import bookmark
page-flipping eBook;

Import links

Enable search

}} Convert to Flash
At last, click

If your PDF file has links, check this to enable in flipbook;
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IX. Use Flip PDF Pro in Command Line

You can also use Flip PDF Pro in Command Line.

Flip PDF Professional Command Line Usage:

PTCMD.exe [Options]

-f<PDF File> The source PDF file.

-o<output folder> Specify the folder for the output files.

-t[html|zip | exe] Output type. Default is html.

-n<OutputFileName>  Specify the name for the output file.

-c<caption> Caption for HTML or EXE.

-s<Flash settings> Value format is:<Template name>#[<Theme name>|
<txt_settingfile path>].
<Template name> could be: Classic, Float, Spread.
<Theme name> are list in the "Select a template" window,
such as Blank,Blues,Nostalgia.
<txt_settingfile path> is the file that you export

with "Save the template settings" function

-r<page range>. The page range that you want to import from PDF File.
Range value string like:2-15,33,35-36,or All.(Default: All)

-g<import quality> Count be 5,4,3,2,1.5 specify the higher quality larger file
size;1 specifies lower quality smaller file size.(default:4)

-R<GS|SWF|LIB> Render engine options. (Default: GS, Ghostscript render
engine)

-b<Y|N> Import bookmark yes or no. (Default: Y)
-I<Y|N> Import links yes or no. (Default: Y).

-S<Y|N> Enable searchable or not.(Default: Y, enable searchable)
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-k<html key words> Set the keywords for html output file.
-d<html description>  Set the descriptions for html output file.
-j<html javascript> Set the javascript for html output file.
-i<icon file path> Specify the icon path for exe output.
-w<window size> Specify the size of exe window.

Value could be: M,F, or some string like:800,600.
(width is 800,height is 600).

Examples 1:
PTCMD -f"C:\input.pdf" -0"C:\outputfolder" -n"index" -thtml -c"Title"
-s"Float#c:\my_ebooksetting.txt" -r"1-8,9-14,42" -q4 -R"SWF" -bN

Examples 2:
PTCMD -f"C:\input.pdf" -0"C:\outputfolder" -n"ExeFileName" -texe -i"C:\app.ico"
-c"Title" -s"Float#Blues" -r"All" -g5 -R"GS"

Examples 3:

PTCMD  -f"C:\input.pdf"  -o0"C:\outputfolder" -n"index" -tzip  -c"Title"
-s"Float#Blank" -r"All" -q5 -R"GS" -k"html key words"\

Return Code:

Success

Input file not found

Parameters are invalid

Failed to load PDF

Failed to import bookmarks

Failed to import links

Failed to import searchable information
Failed to save the output file.

N HREWNR
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License Agreements

All copyrights to Flip PDF Pro (the Software) are exclusively owned by PageFlipping.com. For
more information, visit our website at www.PageFlipping.com .

Anyone may use this software but all the page-flipping eBooks generated will automatically
have a demo watermark on the first page of them. To remove the limitation you must
register.

Once registered, the user is granted a non-exclusive license to use the Software on one
computer (i.e. a single CPU) at a time. The registered Software may not be rented or leased,
but may be permanently transferred, if the person receiving it agrees to terms of this
license.

The Software unregistered (trial) version may be freely distributed, provided the distribution
package is not modified. No person or company may charge a fee for the distribution of the
Software without written permission from the copyright holder.

THE SOFTWARE IS DISTRIBUTED "AS IS". NO WARRANTY OF ANY KIND IS EXPRESSED OR
IMPLIED. YOU USE AT YOUR OWN RISK. THE AUTHOR WILL NOT BE LIABLE FOR DATA LOSS,
DAMAGES, LOSS OF PROFITS OR ANY OTHER KIND OF LOSS WHILE USING OR MISUSING THIS
SOFTWARE.

You may not use, copy, emulate, clone, rent, lease, sell, modify, decompile, disassemble,
otherwise reverse engineer, or transfer the licensed Software, or any subset of the licensed
Software, except as provided for in this agreement. Any such unauthorized use shall result in
immediate and automatic termination of this license and may result in criminal and/or civil
prosecution.

All rights not expressly granted here are reserved by A-PDF Solution.

Installing and using the Software signifies acceptance of these terms and conditions of the
license.

If you do not agree with the terms of this license you must remove the Software files from
your storage devices and cease to use the product.

Copyright 2012 by Page-Flipping.com
-48 -


http://www.flipbuilder.com/

- - : \/ PDF to Professional Page-Flipping eBook Utility
: User Document

How to Order

Order Online (http://www.PageFlipping.com/flip-pdf-pro/index.html) or Order Toll Free

1-877-353-7297 (When you order toll free just give the operator the product number of the
product you would like).

How to purchase online?

1. Select a license type above, and click [Buy Now]

2. Select the currency that you want to use. (You can also continue shopping)

3. Fill billing information and select a payment method. (Your information is safe with us)
4. Check the information you filled previously and click "Place Secure Order"

Other Order Ways—With Phone/Mail/Fax/Check:

If you are not comfortable ordering online witha credit card, you are welcome to choose an
offline order option in the payment section of the order process. We accept mail, fax, wire,
and PO (if applicable) ordering options in addition to ordering online. We also provide
phone orders through our 24x7 order desk at 1-877-353-7297, or (952) 646-5331 for
International Callers.

Please note that all of the offline ordering options do have additional fees for processing. To
place an order by mail, fax, wire, and PO (when applicable), use the online form and then
choose one of these payment options found in the Payment Method section of the form.
Once submitted online, the appropriate information will be provided to you in your web
browser to send your payment to us offline.

100% unconditional 30 Day Money Back Guarantee

Want to custom the program or have other questions about purchase?
Contact us at alice@PageFlipping.com .
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Support

You can easily search or browse our frequently asked questions, and learn tutorials about
products, and get your registration code back. If you are not satisfy with the solutions
provided, please contact support team for help.

1. Frequently Asked Questions

You can find answers to questions about technique issues here:
http://www.PageFlipping.com/support/list-Flip-PDF-pro

2. Learn tutorial about Flip PDF Pro

We publish a video tutorial which shows you the easy procedure of dealing with Flip PDF Pro,
you can view this video to quickly handle the stunning tool:
http://www.PageFlipping.com/demo/flip pdf pro.swf

3. Get lost license code

Click here to look up the order » (http://www.regnow.com/cs/orderStatus)

You can pull up a copy of your order by entering your email address. After you find your
order, you may view its status, view details of your order (including the license key), and
obtain the invoice.

4. Contact Us

If you have other questions or requirements, contact us directly through our support Email:
alice@PageFlipping.com, we will respond you ASAP.
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